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Introducing Multi-SCAN 
for Windows 8 & 10 

Multi-SCAN is a single switch activity center featuring 4 educational games: Dot-to-Dot, 
Find, Match, and Maze; and 6 animation libraries offering a wide range of age-appropriate 
graphics: Animals, Cosmetology, Dinosaurs, Independent Living, Sports, and Vocations. 

 

Multi-SCAN lets you select a graphics library, choose games and set a play schedule for 
each user, and adjust the difficulty level and other settings independently for each game. 

Other features of Multi-SCAN include saving and retrieving custom game setups for each 
user and printing an individual performance report after each play session. 
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The Multi-SCAN Package ....... • Installer CD-ROM for PCs running Windows 8 or 10 

• Multi-SCAN User's Guide (PDF file on CD-ROM) 

• Multi-SCAN registration card 

If you are missing any of the above items, contact 
Academic Software, Inc., at asistaff@acsw.com or 1-859-
552-1020 for replacements. 

Registration ............................. So that we can continue to provide you with the highest 
quality software, offer technical support, and keep you 
informed about new Multi-SCAN software developments, 
please return the enclosed registration card to Academic 
Software, Inc. 

System Requirements ............. To run the Multi-SCAN program, you need: 

• A PC running Windows 8 or 10, either natively or using 
an emulator (such as a Mac running VirtualBox). 

• Optionally, a single-switch interface such as SS-
ACCESS for Windows from ASI for persons who 
cannot use a keyboard or mouse. 

Installation ............................... Multi-SCAN is distributed on a CD-ROM for Windows 8 
and 10 computers. This contains a folder named MS 
Publish containing a “click-once” installer file named 
setup.exe. Double-click this file to run the Installer and 
follow the instructions and prompts to complete the 
installation. A shortcut program icon to run the Multi-
SCAN program will be placed in the Windows START 
Menu APPS list and on the Desktop.1 

At this point, we suggest that you also use Windows File 
Explorer to create a new folder named MultiSCAN. Later 
on, this would be a good place to save custom Multi-
SCAN User Setup files and Lesson Plans. This folder can 
be placed on your c-drive (e.g., c:/MultiSCAN, in your 
Documents folder, on your Desktop, or in another location 
you may choose. 

  

                                                        
1  To uninstall the Multi-SCAN software, use the Programs and Features tool and the Add/Remove Programs option available 

from the Windows Control Panel. For additional information, see the Technical Notes pages at the end of this User’s Guide. 
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Program Overview .........................................................Once you have installed Multi-
SCAN, you are ready to begin 
working with the program. 

Run the program by 
clicking on the 
Multi-SCAN short-
cut Desktop icon. 

The Welcome Screen and Main 
Menu Strip will appear. This 
window can be resized and 
repositioned conveniently on your 
Desktop and these settings will be 
saved automatically when you quit 
the program. 

 
Setting Game Controls  ................... There are two types of game controls you will need 

to set. General game controls affect all of the Multi-
SCAN games. Specific game controls affect each 
game individually. 
 
General Controls: 

Music for the games can be toggled on or off. Pull 
down the Controls Menu and select Music or 
press Ctrl+M on the keyboard. A checkmark will 
appear to show the music is active. To turn the 
music off, just select Music again. 

A beeping tone to accompany the scan also can be 
toggled on/off. Pull down the Controls Menu and 
select Tone or type Ctrl+T. A checkmark will 
appear to show the beep is active. To turn the beep 
off, select Tone again. Use the Windows Speaker 
Icon to adjust the volume of the music and tone.  

IMPORTANT NOTE: Multi-SCAN is shipped with a set of standard default settings. When first opened or whenever the 
Welcome Screen says “Default Setup for New User,” all current displayed settings are “default settings” and - if these are 
changed and you quit Multi-SCAN - they are saved as new “default settings” which will reappear the next time the program starts. 
As explained later, the factory settings can be restored easily. When you create a User Setup file, it inherits the current default 
settings. Then you can customize, save, and retrieve all individual user settings without changing the default settings. 

Multi-SCAN icon 
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The scan speed can be adjusted from .5 seconds up to 5 seconds. Pull down the Controls 
Menu and select Scan Speed. A Scan Speed Screen will appear. Use the up and down arrow 
keys to make changes while observing the effect on the scan speed. 
 
 

 
 
The animation speed can be adjusted for slower or faster movement. Pull down the 
Controls Menu and select Animation Speed. An Animation Screen will appear. The 
animation speed can be set from 0 to 9 units. Higher numbers produce slower animation. 
Use the up and down arrow keys to make changes while observing the effect on the 
animation speed. 
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Multi-SCAN also provides a Switch Key option. This defines the key or combination keys 
on the keyboard that will act as the "hot key" and emulate pressing the real adaptive switch. 
The default setting is the RETURN or ENTER key. However, you may choose, for 
instance, the SPACE BAR to act like the external switch and be a larger target for a user. 
The important thing about the Switch Key is that when you use control interface software 
to allow the computer to respond to pressing an external adaptive switch, that software will 
need to know what is supposed to happen when the switch is pressed. In this case, when the 
external switch is pressed, the interface software should be set to send either a mouse click 
or the current "Switch Key" stroke to Multi-SCAN. 
 
 

 
 

You can select the graphic library to be used with 
the games. Pull down the Libraries Menu and 
select a library. A checkmark will appear to show 
which library is active. 
 

 
The Match, Find, and Dot-to-Dot games can 
access all six libraries. A section at the end of this 
User’s Guide shows all of the graphic animations 
available in each of the libraries. 

  

NOTE: The Maze game is always played with the Dinosaurs library. If 
you choose a different library such as Sports, when the user reaches the 
Play Screen, that library will be used by the Dot, Find, and Match 
games. 
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Specific Controls: 
 
For each game you can select whether the user will 
be able to choose to play the game. You also can set 
the number of iterations, the mode of play, the level 
of difficulty, and other specific options. 

To set the individual game options, pull down the 
Controls Menu and select Set Game Options or 
press CTRL+G. Press Escape or click the small 
box in the middle to return to the Welcome Screen. 

A screen will appear displaying the Dot-to-Dot, 
Find, Match, and Maze game controls. At this 
point you can change Multi-SCAN default 
parameters or set custom parameters for each 
individual user. (To save your custom setup, refer to 
pages 13-14.) 
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Dot-to-Dot Game ............................... The Dot-to-Dot game offers four Modes of Play, 
depending upon the number of dots that are displayed 
for each graphic. Patterns of 3, 6, 9, or 12 dots are 
available. 

You can select one of three Difficulty Levels. A 
Numerical Scan places numbered dots on the screen 
above a number line sorted in numeric order. A Random 
Scan places dots on the screen above a number line 
sorted in random order. In either case, the scanning 
selector moves from left to right across the number line. 
When the user selects the correct number on the number 
line, a line is drawn connecting the appropriate dots in 
the display. 

An On-Screen Scan is also an option. Numbered dots are placed on the screen and the dots 
themselves are scanned in sequential order. When the correct dot is selected, a line is drawn 
connecting the appropriate dots. 

You also can choose to make the game Not Active or Active and control the number of game 
Iterations to be played. For the Dot-to-Dot game, 2 play cycles constitute 1 game iteration. 

 
Finding Game ......................................... This "concentration" game has numerous Modes of 

Play. You select Number of Rows (1, 2, or 3) and 
Number of Columns (2 or 4). This determines the 
number of cards to match. For example: 1 row and 2 
columns displays 2 cards; 3 rows and 4 columns displays 
12 cards. 

Two Scanning Modes are provided. A Linear Scan goes 
from left to right and top to bottom, selecting one card at 
a time. A Row/Column Scan is a two-step selection 
process. At first, the scanning selector moves from top 
to bottom, selecting entire rows of cards. 

When the user selects a row, the scan begins to move from left to right across columns, selecting 
one card at a time. At the end of the row, the column scan reverts to a row scan and continues 
down the display. 

The Difficulty Level can be adjusted in two ways. Including Orientation as a factor makes the game 
more difficult. You also can choose not to Preview the game cards first. If you choose Preview, the 
game cards will appear for several seconds before being covered. The least difficult combination is 
no orientation change and card preview. You also can choose to make the game Not Active or Active 
and control the number of game Iterations to be played. For the Find game, 1 play cycle 
constitutes 1 game iteration.  
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Matching Game ...................................... This game has three Modes of Play. You choose the 
number of distractors (1 Choice, 2 Choices, or 3 
Choices) to compare against the target by clicking in the 
appropriate check box. The distractors can be displayed 
vertically to the right of the target on the screen or 
horizontally below the larger target. 

To make the game available to the user on the Play 
Screen, click Game Active. If you do not want the user 
to have the Matching game as a choice, click Game Not 
Active. You can also control the number of game 
Iterations to be played. For the Matching game, 5 play 
cycles constitute 1 game iteration. 

The game can be made more difficult by choosing to include Orientation as a consideration for 
matching figures. At this level the user must be able to match the correct figure shape and 
distinguish if it is facing in the same direction as the target. For example: 

✖ 

 

✔ 

 

✖ 

 

Maze Game ............................................. The Maze game has two Modes of Play: a scanning 
mode and a cause & effect mode. 

In the Scanning mode, the maze appears on the screen 
above a scanned array of four large directional arrows. 

In the Cause & Effect mode, only the maze appears on 
the screen. In this mode, each time the user activates the 
switch, the character moves one step through the maze in 
the correct direction to eventually reach a goal and enjoy 
a celebration. 

To make the game available to the user on the Play Screen, click Game Active. If you do not want 
the user to have the Maze game as a choice, click Game Not Active. The slide switch indicator 
toggles right or left when clicked. 

You can set the number of times the user can play the game before the program returns to the Play 
Screen. (There the user can play the game again (in the Continuous Play mode) or choose a 
different game.) The number of Iterations can be set from 1 to 9 by repeatedly clicking on the 
control box. For the Maze game, 1 play cycle constitutes 1 game iteration. The Maze game offers 
three different mazes and the user can choose which one to play each play cycle.  
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Set Game Defaults .................................. When Multi-SCAN starts, all game controls are set to 
default values. During setup these defaults can be 
changed and saved. Custom setups for individual users 
can be created, edited, saved, and retrieved. Choosing 
Set Game Defaults is a quick way to restore all current 
custom User Settings to the current default settings. 

Original general game default settings affecting all 
games include: 

Music ........................... On 
Tone ............................. Off 
Scan Speed .................. 1 sec 
Animation Speed ........ 4 units 
Switch Key .................. Return or Enter key 
Activity ........................ Continuous Play 
Library ........................ Dinosaurs 

The Game Control Panel on page 6 illustrates all game-specific default settings. All of these can 
be changed and saved as new default settings (by quitting the program after making changes when 
the user is New User). The original default settings (both general and game-specific) shown above 
can be reset quickly using the Help Menu. 
 
File Menu ........................................ In addition to the Play Games option, other options available 

under the File Menu include standard and custom 
input/output functions. 

Custom features allow you to save and retrieve game setups 
for each user and to print out an individual performance 
report after each play session. 

To save game setups under a user's name, pull down the File 
Menu and select New User. A prompt will appear asking you 
to "Please type a User Name:" in a highlighted text box. Type 
a name for the setup you are saving (40 characters 
maximum). Click the OK button to the Welcome Screen and 
the new user's name will appear in the bottom right corner 
along with the current date. Now set the game options for the 
new user (refer to Set Game Options). Once you have 
created the setup for this user, pull down the File Menu again 
and select Save or Save As... 

To open an existing user setup, pull down the File Menu and select Open User. The standard 
Windows Open File dialog box will appear. Select the folder and the user file you want and click 
Open. The program will not allow you to open a file that is not a Multi-SCAN setup file.   
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Multi-SCAN is now customized and ready for the user. To activate the games, pull down the 
File Menu and select Play Games or press CTRL+P. The Play Screen will appear in scan 
mode. The user selects a game by activating an external adaptive switch (or by clicking the 
mouse button or pressing the Switch Key - by default, the Enter or Return key) when the 
scan reaches the desired icon. (In Multi-SCAN, pressing the ESCAPE key always returns 
control to the previous window.) 
 

 
 

 
 
 
 
Dot-to-Dot Game Play 
 

Finding Game Play 
 
 
 
 
 
 
 
Matching Game Play 
 

Maze Game Play 
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Printing Performance Reports .... A Multi-SCAN Play Report can be viewed and/or 
printed at any time by selecting Play Report from the 
File Menu or pressing CTRL+R. The report shows the 
user name, date, and all current game settings as well 
as play results. 

Play results are shown for the cumulative play 
sequence of each game. The Optimal Score shown is 
based on the minimum number of switch activations 
(i.e., correct choices) needed to complete a game and 
the pre-set number of game iterations. For example, 
since only 1 choice per Matching game is required and 
there are 2 play cycles per Iteration, then if 
Iterations=5, the Optimal Score for that play sequence 
would be 10.  

For the Finding game, there is only 1 play cycle per iteration. So the Optimal Score is the 
number of pairs of icon choices times the pre-set number of game iterations. (The # of pairs 
is the # of rows times the # of columns divided by 2.) 
For the Dot game, the Optimal Score is the number of dots per game times 2 plays per 
iteration times the number of game iterations. The Maze game is more complicated since 
each maze may be played more than once and in any order. The Optimal Score is computed 
for a particular sequence of maze game choices. Play Attempts record the actual number of 
(correct or incorrect) choices made by the player during a game sequence. The Success 
Rate is the percentage ratio of Optimal Score and Play Attempts. The Elapsed Time is the 
number of minutes that the user (1) spent continuously playing each game activity or (2) 
required to complete a Lesson Plan. General Success is a weighted average of game success 
rates. Lesson Time is the sum of individual game times. 
Pressing the ‘P’ key when viewing the Play Report will evoke the standard Windows 
Printer dialog box. Using that control you can send the report as an image to your printer 
or save it as a PDF file. It is best to view and print reports immediately after users complete 
full play sequences for all selected games. 
After Continuous Play if the user wishes to check data or change options (e.g., libraries) 
or after finishing a Lesson Plan, someone (perhaps a teacher or helper) must press the 
Escape key from the Play Games Screen to return to the Welcome Screen and Main 
Menu. Then, to resume play, each time Play Games is selected from the File Menu, Multi-
SCAN checks to see if game data is available. If so, a dialog box asks whether (1) game 
data should be reset as play is resumed or (2) game data should continue to be accumulated 
for this user or (3) the request to play games should be cancelled (e.g., to go back and print 
the current Play Report).  
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This illustration shows the initial state of the Play Report while the current “user” is New 
User. The settings shown are therefore the current default settings that Multi-SCAN is 
using. Once a new User Setup is created or a saved User Setup is opened, the current 
custom settings for that particular user will be displayed. 
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Lesson Planning and Lesson Plans: 
A Detailed Walk-Through 

 
 
In this tutorial, we will create a new User Setup for a student named Warren and configure 
that setup as a Lesson Plan activity that can be saved and recalled again for further directed 
practice. 
 
When Multi-SCAN starts, the Welcome Screen appears on the Desktop with the size and 
in the position it was in the last time the program was closed. The last default settings are 
loaded automatically and the Welcome Screen shows “Default Setup for New User.” 
 
Step 1: Our first step will be to 

pull down the File 
Menu and select the 
New User option (or 
press CTRL+N). The 
New User Screen 
opens and we can type 
a name (up to 40 
characters in length) in 
the displayed textbox. 

 

 
Step 2: For this tutorial, we will enter a name and identify this User Setup as a Lesson 

Plan by typing “Warren – Lesson 1” (without the quotes). This is also an 
acceptable Windows filename. 

Step 3: Next we can click the OK Button to return to the Welcome Screen. 
 
At this point, the Title Bar and the information box on the Welcome Screen show that 
Multi-SCAN is “Specially Setup for Warren – Lesson 1” as illustrated on the next page. 
Initially the current default settings have been copied into the custom setup for this user. 
We will be changing most of these. But, first, this would be a good time to initially save 
this User Setup.  

IMPORTANT NOTE: The User Name we enter is also used as the filename for the User Setup file 
which we will save using Windows. Therefore, this name MUST conform to standard Windows file 
naming conventions. Multi-SCAN attempts to check this name and will prompt the user if it contains 
illegal characters or words. The small HELP button in the New User Dialog Box provides more 
information. 
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Step 4: Pull down the File Menu and select the Save User option. If this User Setup has 

never been saved, this will open a standard Windows Save As… dialog box 
showing Warren – Lesson 1.mscan in the File name textbox. You can choose a 
location to save this User Setup. We recommend saving your setups in a folder 
named MultiSCAN or MultiSCAN Setups (which you may have created for this 
purpose earlier). The Save and Open dialogs shown below remember the last 
folder location where setup files were saved. 
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Step 5: This is also a good place to practice opening a User Setup. Pull down the File 

Menu again and select the Open User option. This will open a standard Windows 
Open dialog box (illustrated above). Select the location or folder where you saved 
the Warren – Lesson 1.mscan setup file. Notice that all Multi-SCAN setup files 
are saved with the .mscan custom file extension and only these files are shown in 
the dialog box. Select the Warren – Lesson 1.mscan setup file by clicking on it. 
Then click the OPEN button. This action returns the display to the Welcome 
Screen showing that this user setup is currently the one that is loaded. At this 
point we are ready to begin customizing this Lesson Plan for this particular user. 
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Step 6: Perhaps the first thing to do is to pull down the Controls Menu and click on the 
Lesson Assignment option. The checkmark that was by Continuous Play moves to 
Lesson Assignment. The significant difference is that when the Play Games option 
is chosen and the user begins the lesson, he or she is asked to complete a pre-

defined series of iterations of a set of selected play 
activities. As the active games are completed, they 
cannot be played again. Eventually all activities are 
completed and the lesson is over. At the point an 
attendant can press the Escape key to return to the 
Welcome Screen and view and print a full Play 
Report for the finished lesson. 
 
However, before that, the general parameter settings 
need to be checked and the specific game parameters 
need to be set to define this Lesson Plan for this user. 
And, after that, the new User Setup needs to be saved 
again. 

 
 
 
 
Let us consider a user who is a young or developmentally young student who can use the 
mouse click (a mouse button or touchpad tap) or an external adaptive switch reliably but 
cannot use the keyboard well. This student needs psychomotor skill practice using scanning 
to select control inputs as well as cognitive skill practice in domains such as counting (Dot-
to-Dot), memory (Find), pattern recognition (Match), and goal-oriented problem solving 
(Maze). We want to create a custom Lesson Plan setup for this user that will be quick and 
relatively easy to play and complete successfully. The student likes to see familiar people 
doing familiar things in the daily environment. 
 
First, we should consider general parameter settings. We conclude that Music=On, 
Tone=Off, Scan Speed=1, and Animation Speed=4 (the standard defaults) are reasonable 
beginning settings for this user. If we are using an external switch with control interface 
software, we have the Multi-SCAN Switch Key set to ENTER and the control interface 
software set to send that keypress to Multi-SCAN each time the switch is activated.2 
 

                                                        
2  It is always important to remember that an application like Multi-SCAN must have the Windows focus to receive mouseclick 

or keystroke messages from the keyboard, the mouse, or other control interfaces. Clicking on a window gives it the focus. 
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Step 7: Since the user enjoys familiar people doing familiar things, pull down the 

Libraries Menu and click on the Vocations option. 
Step 8: Next, pull down the Controls Menu and click on Set Game Options. This will 

open the Game Controls Screen and we will choose the settings shown above. 
Step 9: Consider the Dot-to-Dot settings pane. We want a short and simple lesson. There 

are two play cycles per iteration in this game so Iterations=1 would be a good 
setting. Click on the Iterations control repeatedly until the number cycles around 
to 1. To keep the game relatively simple, also click on the checkboxes for 3 dots 
per image and for a scanning number line (left to right in numerical order) for 
Dot selection. 

Step 10: Consider the Find settings pane. Find games tend to take longer so there is only 
one play cycle per iteration in this game. Iterations=2 would be a good setting. 
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Click on the Iterations control repeatedly until the number cycles around to 2. 
Again, to keep the game relatively simple (but still emphasize pattern 
recognition), also click on the checkboxes for Card Orientation=Yes, Card 
Preview=Yes, and for Rows=2 and Columns=2. For advanced scanning practice, 
click on Row/Column scanning. 

Step 11: Consider the Match settings pane. Match games play very quickly so there are 
five play cycles per iteration in this game. Iterations=1 would be a good setting. 
To keep the game relatively simple, also click on the checkboxes for Card 
Orientation=Yes and for Number of Choices=2, arranged Vertically to the right 
of the target. 

Step 12: Consider the Maze settings pane. We want the user to use the scanning selector 
to solve the Maze problem. There is only one play cycle per iteration in this game 
so Iterations=2 would be a good setting. Also click on Scanning as the mode of 
play. 

Step 13: Make sure in all four panes, that the slide switch control for each game is set to 
Game Active. (Otherwise the game would not appear as an activity for the user 
to play during the lesson.) 

Step 14: When all of the specific game settings match those shown in the illustration 
above, press the Escape key or click on the small checkbox in the middle of the 
screen to return to the Welcome Screen. 

Step 15: Pull down the File Menu and choose the Save User option. This will save 
immediately save the current User Setup (with all the changes you just made) in 
the location and with the same filename as the setup had when you opened it (in 
Step 5 above), replacing the previous version. Alternately, you could select the 
Save As… option to rename the User Setup file and/or save it in a different 
location. 

The current User Setup Lesson Plan is ready for the user to play through to completion. 
To double-check everything and perhaps print a record showing the Lesson Plan design: 
Step 16: Pull down the File Menu and select the Play Report option. This Play Report 

Screen should resemble the one shown below. At this point, pressing the “P” key 
on the keyboard will open the Windows Printer dialog box. 
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Step 17: When the user is seated and positioned and ready to work through the lesson, an 

attendant would pull down the File Menu and select the Play Games option. The 
Play Games Screen will appear showing all the games that are Active for this 
Lesson. When the user selects a 
game and plays through all of the 
pre-defined Iterations and play 
cycles successfully, control 
returns to the Play Screen for 
the user to select another game. 
The Game Icon for the finished 
game will appear dimmed and 
the scanning game selector will 
skip over that icon. (This 
illustration shows that both the 
Dot-to-Dot and Match games 
are completed, with Find and 
Maze still to play.)  
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Step 18: Upon completion of all game activities in the Lesson Plan, the user is rewarded 
by the “Good Job!!” message and play stops. At this point the attendant would 
press the Escape key on the 
keyboard to return to the 
Welcome Screen. 

 
Step 19: Next (before doing anything 

else), the attendant should pull 
down the File Menu and select 
the Play Report option. The 
illustration below shows a 
typical set of lesson results. This 
would also be a good time to 
print this report, either for the 
user or for attendant record 
keeping purposes. 
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Technical Information 
 
Restoring Factory Game Default Settings .... Multi-SCAN default settings can be 

customized easily by changing the general 
and/or specific game settings when a 
custom User Setup file is not loaded (i.e., 
when the user is New User). At that point, 
quitting Multi-SCAN saves the current 
settings as new default settings to load the 

next time the program runs. However, there may often be times when you may want to 
restore the original default settings just as easily. To do that, pull down the Help Menu 
and select the Reset Game Defaults option. A warning message box pops up to remind you 
that this operation requires the program to quit, giving you an opportunity to save any User 
Setup or Play Report. If you are ready to reset, click on the OK button. Multi-SCAN will 
close and the next time the program runs, it will display the factory default settings. 
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To Install Multi-SCAN Using the ClickOnce Installer Program ........ A ClickOnce setup.exe Installer 
is a special Microsoft program provided to install ClickOnce application programs "safely" on Windows 
computers. In addition, the Installer places an "application reference" shortcut icon (that points to the 
MultiSCAN.exe program wherever that is installed) in the Windows START SCREEN APPS list and 
on the user's Desktop. Further, it facilitates completely removing the program using the Windows 
Add/Remove Programs tool. 

Your Multi-SCAN CD-ROM contains several directories. These include: 
• MS Publish  ............. This contains all the files needed to install Multi-SCAN automatically as a 

ClickOnce application on your hard disk. 
• MS Release  ............. This contains files for manual copying and stand-alone use, without using 

the Installer. All files in this directory are necessary and must be kept together. 
• SS-Demo Publish .... This contains all the files needed to install SS-Demo (a fun, free single-

switch program example) automatically as a ClickOnce application on your hard disk. 
• SS-Demo Release  ... This contains files for manual copying and stand-alone use, without using 

the Installer. All files in this directory are necessary and must be kept together. 
There may also be a file named MultiSCAN Users 
Guide.pdf (this User's Guide) and a file named 
readme.txt containing useful notes and 
information not available when this User's Guide 
was written. 

To install Multi-SCAN on your computer, open the 
MS Publish directory and double-click on the 
setup.exe file. This will evoke the Application 
Install window shown here. ClickOnce 
applications are "signed" and certified programs. 
They can use an official registered "certificate" 
from a certification guarantor or they can use a 
company-signed certificate. In the former case, the 
Publisher field identifies the company that paid the certification guarantor for that service. In the latter 
case, the Publisher field is "Unknown Publisher." Academic Software, Inc. uses a company-signed 
certificate. If you trust that your software came from ASI or its distributors, then click Install to proceed 
and follow any further prompts. Otherwise, you cannot use the ClickOnce Installer. 

To copy and/or run Multi-SCAN manually as an ordinary executable Windows program ..... If you 
choose not to use the Installer, copy the entire MS Release directory (with all of its files) from your CD-
ROM to your Desktop or to your hard drive (e.g., into a c:\ASI directory that you create for ASI software). 
It would be a good idea at this time to right-click on the MultiSCAN.exe file in the MS Release folder 
you copied and select the Create shortcut option. Then move the resulting shortcut icon to your Desktop. 
You can run Multi-SCAN by clicking on this shortcut icon or by opening the MS Release directory folder 
and double-clicking directly on the MultiSCAN.exe program file. (You can also run Multi-SCAN the 
same way directly from your Multi-SCAN Software CD-ROM itself.3)  

                                                        
3 Note if you run Multi-SCAN directly from the CD-ROM, you will not be able to print the Play Report because the application 

cannot write the printer spool file to the read-only CD-ROM. 
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To copy and print this User's Guide .......... This User's Guide is distributed on the Multi-SCAN 
Software CD-ROM as a PDF file. It is also a part of the Multi-SCAN program files and can be called up 
from within Multi-SCAN through the Help menu by selecting the User Guide option. As a PDF file, the 
free and widely available Adobe Acrobat Reader or some other similar PDF file reader program is required 
as a default program to open PDF files such as MS Users Guide.pdf. If need be, we suggest that you visit 
the Adobe website at https://get.adobe.com/reader and download this free program. 
Adobe Acrobat Reader provides many options for reading and printing PDF files, including double-sided 
booklet formats. (This User's Guide is also available in bound book and e-book formats from ASI for 
assistive technology centers, schools, professionals, and other users.) 

What is the SS-Demo Program? ..... A demonstration program is provided for you to test the 
use of an external adaptive switch with another program besides Multi-SCAN. The SS-Demo 
ClickOnce Installer installs this program and adds an icon for it to the Windows START 
SCREEN APPS page and to the Desktop. 
 
Run this demo by double-clicking its Desktop icon. A scene will appear and music plays. Along comes a 
character. This simple program is pretty much self-explanatory. 
 

If you have a multi-function switch interface (like 
WinSCAN from ASI), you can configure a 
scanning control to access all of the command 
buttons. If you have a single-function switch 
interface (like SS-ACCESS from ASI), you can 
configure it to send either the ENTER key or the 
S-key to stop the character using an external 
switch. Another press of the switch will paste the 
original character in place and begin moving a 
copy of that character to the left. Continue pressing 
the switch to paste and move as many characters 
as you wish!4 Use the regular keyboard to enter 
other commands: e.g., press A to view the program 
credits or Q to quit. 
 

 
 

Multi-SCAN requires .Net 4.5.1 Framework ......... Microsoft Windows, since version 7, comes 
equipped with .Net core software and will update that as needed automatically over the Internet. Thus for 
installation on an older computer, an Internet connection may be required. You may need administrator 
access to your computer for this. 

 
This completes your software installation. 

  

                                                        
4 After 10 characters are added, the SS-Demo display starts over. The window can be resized. 
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Available Graphics Libraries 
 

Animals Library 
 

 
Cosmetology Library 
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Dinosaurs Library 
 

 
Independent Living Library 
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Sports Library 
 

 
Vocations Library 
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DISCLAIMER OF ALL WARRANTIES AND LIABILITIES 
Academic Software, Inc., and its suppliers make no warranties, either express or implied, with respect to 
this user's guide or with respect to the software described in this user's guide, its quality, performance, 
merchantability, or fitness for any particular purpose. In no event will Academic Software, Inc., or its 
suppliers be liable for direct or indirect, incidental, or consequential damage resulting from any defect in 
the software, even if Academic Soft- ware, Inc., has been advised of the possibility of such damages. 
Some states do not allow the exclusion or limitation of implied warranties or liabilities for incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. 

COPYRIGHT INFORMATION 
This manual and software are copyrighted and may not, in part or in whole, be copied, reproduced, 
translated, or reduced to any electronic medium or machine readable form without prior consent in 
writing from Academic Software, Inc. Willful violations of the copyright law of the United States can 
result in civil damages of up to $50,000 in actual damages, plus criminal penalties of up to one year 
imprisonment and/or a $10,000 fine. 

 
 
IBM is a trademark of International Business Machines, Inc. Windows 8 & 10 are trademarks of 
Microsoft, Inc. Macintosh is a trademark of Apple Computer, Inc. Adobe Acrobat Reader is a trademark 
of Adobe Systems, Inc. SS-ACCESS is a trademark of Academic Software, Inc. 
 
 

A PORTION OF THIS MATERIAL IS BASED UPON WORK SUPPORTED BY THE US 
DEPARTMENT OF EDUCATION UNDER CONTRACT NUMBER ED-99-PO-4652. ANY 
OPINIONS, FINDINGS, CONCLUSIONS, OR RECOMMENDATIONS EXPRESSED IN THIS 
PUBLICATION ARE THOSE OF THE AUTHORS AND DO NOT NECESSARILY REFLECT THE 
VIEWS OR POLICIES OF THE US DEPARTMENT OF EDUCATION. 
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